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DDDIIISSSCCCLLLAAAIIIMMMEEERRRSSS   AAANNNDDD   WWWAAARRRRRRAAANNNTTTYYY   
 
WARNING: This electronic chart is an aid to navigation designed to facilitate the use of authorized 
government charts, not to replace them. Only official government charts and notices to mariners contain 
all of the current information needed for the safety of navigation, and the captain is responsible for their 
prudent use. 

The program and its charts do NOT excuse the user from carrying the required official charts 
and documents. 

Raymarine, Inc., ("Raymarine") does not warrant that this Product is error free or that it is compatible 
with products manufactured by any person or entity other than Raymarine.  

This Product utilizes digital chart data, and electronic information from the Global Positioning System 
("GPS") and weather information which may contain errors.  Raymarine does not warrant the accuracy of 
such information and you are advised that errors in such information may cause the product to malfunction 
or give incorrect readings.  Raymarine is not responsible for damages or injuries caused by your use or 
inability to use the Product, by the interaction of the Product with products manufactured by others or by 
errors in chart data or information utilized by the Product provided by third parties. 

Except for the limited warranty regarding the magnetic media contained in the license agreement 
accompanying the Product, this Product is provided "AS IS" without warranty of any kind, either 
express or implied, including but not limited to the implied warranties of merchantability and fitness 
for a particular purpose, and any others which may arise from course of performance, course of dealing, 
or usage of trade. 

WARNING: Nautical navigation is an inherently dangerous undertaking and should only be engaged in 
by persons trained and experienced in navigation. This Product is intended for use only by persons 
trained in nautical navigation and only as a navigational aid, not as the sole method of navigation. 

NOTICE: You may not use this Product unless you agree to the terms of the license agreement. By 
pressing the button titled "I AGREE", you agree to be bound by the terms of the license agreement and to 
release and hold Raymarine harmless from and against any and all claims, obligations, and liabilities with 
respect to the Product, except those specifically reserved in the license agreement. If you do not agree with 
the terms of the license agreement, press the button entitled "I DO NOT AGREE" and the program will 
exit. If you choose this option you may return the program within thirty (30) days of the date of purchase 
by following the instructions contained in the license agreement. 

First Edition, February 2002  Document Number:  81207_1 
Copyright ©, Raymarine, Inc., 2002  All Rights Reserved. 
Windows and NT are registered trademarks of Microsoft, Inc.  Pentium is a registered trademark of Intel.   
NVIDIA and GeForce are trademarks or registered trademarks of NVIDIA, Corp.  Maptech is a registered trademark 
of Maptech.  C-Map and C-Map NT are registered trademarks of C-Map SRL.  SeaTalk is a trademark of Nautech 
Limited.  Raymarine is a registered trademark, and Navigator is a trademark, of Raymarine, Inc.  All other product 
names mentioned are trademarks or registered trademarks (if applicable) of their respective companies.  RayTech 
Navigator has been licensed subject to a license agreement between you and Raymarine, Inc.  Under copyright laws, 
use of this manual is intended for the original licensee.  No portion of this manual may be reproduced or transmitted 
in any form by any means, electronic or mechanical, including photocopying, recording, or information storage and 
retrieval systems, for any purpose other than the licensee’s use, without express written permission of Raymarine, Inc., 
and provided in the licensing agreement between you and Raymarine, Inc. 

Printed in the U.S.A. 
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AAAbbbooouuuttt   TTThhhiiisss   UUUssseeerrr’’’sss   GGGuuuiiidddeee   
 
 
GGGuuuiiidddeee   DDDeeessscccrrriiippptttiiiooonnn   
 

This User’s Guide describes how to install and operate Raymarine’s 
RayTech Navigator marine navigation software.  It assumes that the 
PC on which the software will be installed meets the requirements for 
running Navigator (see Chapter 2 for details), and that all peripheral 
equipment that you intend to operate concurrently with Navigator has 
been installed and is fully operational and compatible.  In many cases, 
you will be directed to refer to the user manual(s) that came with your 
peripheral devices for specific installation/operation instructions. 
 
This Guide is intended for users with varying technical and nautical 
backgrounds, but assumes a general level of PC and related software 
environment experience, as well as a moderate knowledge of nautical 
terminology and practices.  Certain portions of Navigator and this 
Guide are targeted toward the experienced sailor, and these areas 
are clearly identified as such. 
 

TTTeeeccchhhnnniiicccaaalll   AAAccccccuuurrraaacccyyy   
 
The technical and graphical information contained within this User’s 
Guide, to the best of our knowledge, was correct at the time of printing.  
However, Raymarine’s policy of continuous product improvement and 
updating may change product specifications and operating nature with 
out prior notice.  As a result, unavoidable differences between the 
product and this Guide may occur from time to time, liability for 
which cannot be accepted by Raymarine. 
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CCCooonnnvvveeennntttiiiooonnnsss   

This section explains and gives examples of the writing conventions and margin symbols 
used within this Guide. 

GGGeeennneeerrraaalll    CCCooonnnvvveeennntttiiiooonnnsss   
 

Ø Text that represents items you see on the screen are shown 
in this font.  For example: 

On the Polars screen, click the Polar tab. 
 

Ø Text that represents text you are required to type-in is shown 
in this font.  For example: 

Point your browser to www.raymarine.com. 
 

Ø When you are required to access/choose items from drop-down 
menus, the word select is used.  Menus levels are shown 
separated by a forward slash “/”.  For example: 

From the File menu, select Setup/System. 
 

Ø When you are required to “press a button” on the screen, 
the word click is used.  For example: 

Click Apply to plot new variables after editing. 
 

MMMaaarrrgggiiinnn   SSSyyymmmbbbooolllsss   
 
 

Ø When you see the  symbol in a margin it means there is an 
important Note worth reading within the accompanying text. 
 
 

Ø When you see the  symbol in a margin it can indicate a tip, 
words to the wise, or simply some additional, useful information. 
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PPPrrroooddduuucccttt   TTTeeeccchhhnnniiicccaaalll   SSSuuuppppppooorrrttt   
 

This section gives National and International telephone numbers, email 
and surface mail addresses, and an Internet address for use should you 
encounter any difficulties while using RayTech Navigator. 

 
TTTeeellleeeppphhhooonnneee   (((UUUnnniiittteeeddd   SSStttaaattteeesss)))   

Toll-Free: 1-800-539-5539  X2333 
Standard: 1-603-881-5200  X2333 

FAX: 1-603-864-4756 
 
TTTeeellleeeppphhhooonnneee   (((EEEuuurrrooopppeee)))   

Telephone: +44 (0)23 9271 4713 

FAX: +44 (0)23 9266 1228 
 
EEEmmmaaaiiilll   AAAddddddrrreeessssss   

techsupport@raymarine.com 
 
MMMaaaiiillliiinnnggg   AAAddddddrrreeesssssseeesss   

United States: Raymarine, Inc. 
 22 Cotton rd, Unit D 
 Nashua,  NH  03063-4219 

Europe: Raymarine Ltd 
 Anchorage Park 
 Portsmouth, Hampshire 
 England PO3 5TD 

 
IIInnnttteeerrrnnneeettt   

www.raymarine.com
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Welcome to RayTech Navigator 
This User’s Guide describes how to use Raymarine®’s RayTech 
Navigator marine navigation software (Figure 1-1).  RayTech 
Navigator operates within a standard Windows® environment, and 
enables you to utilize the latest digital charts and Global Positioning 
System (GPS) instrumentation to help you pilot your vessel to virtually 
anywhere in the world.  Navigator easily interfaces with your boat’s 
onboard navigational systems, offering you the flexibility to allow 
Navigator to autopilot your vessel to any destination you choose to 
plot.  Navigator also incorporates the capability to download the latest 
weather and oceanographic information and display it on any chart, 
thus keeping you apprised of foul weather near you or your destination.  
Furthermore, Navigator is the perfect choice for the serious sailor 
or fisherman, offering advanced optional modules that enhance 
Navigator’s route-plotting and fish-finding performance.  The subsec-
tions that follow detail the sophisticated capabilities and features of 
RayTech Navigator. 

 

Figure 1-1.  Typical RayTech Navigator Chart Screen 
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Easy Marine Navigation Using Routes and Waypoints 

RayTech Navigator takes the guesswork out of marine navigation by 
enabling you to easily chart, plot, and execute simple or complex 
routes.  A route is composed of a series of waypoints that you select 
on the screen, with each waypoint denoting a certain position along 
the path of the route.  A route typically has a starting waypoint and an 
ending waypoint, and as many intermediate waypoints as you need or 
want.  Using Navigator, you can create a route to any destination with 
a few simple clicks of the mouse, and then follow it manually or 
enable your vessel’s autopilot to follow the route/waypoints you have 
designated.  Routes and waypoints can easily be changed “on the fly,” 
should weather or other factors necessitate a change in course. 
 

Multiple Chart Formats for Flexibility 

Navigator uses the latest digitized versions of the paper charts 
traditionally used in marine navigation, and supports a variety of 
popular chart formats: 

• C-Map® NT 

• Maptech® NOAA/BSB 

• Maptech PCX 

• Maptech Photo Regions and Topographical Charts 

• SoftCharts® Nautical Charts and PhotoNavigator 

These charts fall into three basic types:   

• Vector –  A paper chart that has been digitized 
into a format consisting of line segments.  
Vector charts can be easier to read than 
a rasterized chart, but may not include 
the level of detail found in Raster charts.  
The C-MAP chart is an example of a 
vector chart. 
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• Raster –  A paper chart that has been scanned into 
a high resolution image.  A raster chart 
has the advantage of being virtually 
identical to the original paper chart from 
which it was scanned.  The MapTech 
NOAA/BSB and PCX charts are 
examples of raster charts. 

• Aerial Imagery – A high resolution, geo-referenced rasterized 
photograph taken from aerial or satellite 
sources.  You can overlay your vessel’s 
position on such an image, and get a 
visual estimation of your position with 
reference to actual, photography-based 
landmarks.  The MapTech Photo Region 
chart is an example of an aerial imagery 
chart. 

 

Comprehensive Weather/Oceanographic Reporting 

Navigator offers you the capability to download and display the latest 
weather and ocean conditions, and then superimpose this information 
upon your charts in several layers.  Weather and oceanographic (sea 
tides and currents) files (in GRIB format) can be downloaded directly 
from the internet or requested via email.  After you have acquired your 
files, you can fully animate them to show the predicted weather and 
ocean currents over a specified period of time.  Typical weather files 
contain information in 6, 12, and 24 hour intervals, covering a period 
of several days.  Navigator can further break this information down 
into intervals as small as 30 minutes, giving you a comprehensive 
presentation of atmospheric and marine conditions. 
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Advanced Graphical User Interface with  
Customizable Toolbars/Displays 

You operate Navigator via an easy-to-use Graphical User Interface 
(GUI) complete with many customizable Toolbars, Function bars, and 
“floating” Databoxes (Figure 1-2).  Using an intuitive menu hierarchy, 
you can display only those tools that you commonly use, or customize 
screens to show you only pertinent information, with just a few mouse 
clicks.  You can zoom deeply into charts to display the maximum level 
of detail for the region you are in, animate weather and oceanographic 
files to monitor the meteorological events in your area, and create 
comprehensive logs containing virtually every piece of data that you 
might encounter and collect on a voyage.  Navigator’s flexible GUI 
enables you to tailor its powerful resources to suit your needs quickly 
and easily. 

 

Figure 1-2.  Navigator’s Toolbars, Functionbars, and Databoxes 

 

Toolbars, Function bars, and Databoxes can 
be moved and displayed anywhere you need 
them 
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Integrates with Raymarine’s SeaTalk® and NMEA 0183 
Data Output Devices 

Navigator is designed to work transparently with Raymarine’s SeaTalk 
data communications package, or any other device that outputs data 
in NMEA 0183 format.  This enables parameters such as Heading, 
Wind Speed/Direction, Sea Temperature, and a variety of others to be 
accessed and displayed within Navigator.  Navigator can also connect 
to such onboard systems as Ockam, B&G, and KVH via a standard 
RS-232 data cable.  This enables the information collected by 
Navigator to be relayed and displayed on your vessel’s standard 
onboard instrumentation systems.   

Navigator also connects to Radar systems that are capable of 
outputting Cursor Range and Bearing, and also to ARPA Radar 
systems.  This allows targets identified by Radar to be plotted on 
directly onto Navigator’s chart displays.  You can also connect 
Navigator to a variety of proprietary instruments, and generate 
comprehensive log files which can then be analyzed from within 
Navigator or saved and exported for future external analysis.  

3-D Contour Display  

Navigator’s advanced 3-D Contour Display shows your vessel, the 
ocean floor, and other related information using a 3-D vector-style 
display.  This enables you to view any area, such as favored fishing 
and sailing spots, harbor entrances, and so forth, within a full, 3-
dimensional window.  Images can be rotated 360° so you can view 
your vessel’s position from virtually an angle.  3-D Contour gives you 
useful navigational perspectives that you might not be able to ascertain 
from a conventional display.   

The 3-D Contour Display includes:   

• Past navigational markers 

• Depth markers 

• Transducer cone images 
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Optional Modules 

RayTech Navigator offer two comprehensive optional modules to 
increase Navigator’s capabilities:  Sail Racer and Fishing Pro. 

Sail Racer Module 

Navigator’s Sail Racer Module is targeted toward the professional 
sailboat racer, and includes DataTrak, Polars, Route Optimization, 
Advanced Weather Routing, Pre Start display, Navigation Numbers, 
and a specialized Racing toolbar.   

• DataTrak is an instrument-recording program that captures a 
variety of incoming navigational and performance-related data 
and displays it on time-based graphs in multiple windows.   

• Polars uses a group of variables (such as apparent/true/ 
corrected wind angles, boat speed, heel/pitch, and so forth) 
to determine what heading you should set your boat upon to 
achieve the best possible speed under varying wind conditions.  
Analysis results are displayed using multiple graph plots which 
you can modify (edit) to suit your needs.   

• Route Optimization determines your ideal route based upon 
ocean current, wind speed and direction, in addition to your 
vessel’s Polar characteristics, then plots this route upon the 
chart you desire. 

• Advanced Weather Routing consists of detailed, 7-day 
animated weather files, text-based advisories for North 
American coastal regions, and offshore forecasts/advisories. 

• The Racing toolbar displays special icons that are used within 
racing environments such as The America’s Cup, and enables 
you to set marks and courses quickly and accurately based upon 
GPS or laser-guided input. 
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Fishing Pro Module 

The Fishing Pro Module enables you to use Navigator to easily locate 
the world’s best fishing areas using up-to-the-minute, satellite-based 
oceanographic data.   

The module includes: 

• The latest ocean temperature data presented as overlays 
upon your navigational charts to aid you in finding the 
warmer locations where fish may be hiding. 

• Plankton content areas of the ocean presented as overlays 
upon your navigational charts so that you can easily 
identify clear, fish filled waters. 

• 3-D bathymetric charts to precisely identify ocean bottom 
contours, enabling you to readily pinpoint the areas where 
fish are more likely to concentrate. 

• Complete engine monitoring capability, which displays 
a realistic on-screen gauge cluster (including tachometer, 
oil pressure, turbocharger boost, and more).  This feature 
allows you to easily check your vessel’s engine-related 
systems from within Navigator. 
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Overview 
This chapter explains how to install RayTech Navigator onto your PC, 
and contains the following: 

• Minimum and recommended system requirements 

• How to set your PC to display Navigator in optimal color 

• Installing Navigator from CD-ROM 

• Installing Navigator from the Internet 

 

Note: How to connect external devices such as GPS, 
Radar/Sonar, and autopilots is explained in 
Appendix A, “Connecting Peripheral Instruments.”  

 

Before You Begin 
Before you can begin installing Navigator, you need to make sure that 
the PC you intend to use meets the minimum hardware requirements 
for running the software.  This subsection lists the minimum and 
recommended hardware requirements that your PC must comply 
with to properly run Navigator.  It also explains how to set your PC 
to display the best color scheme within Navigator, and also how to 
connect any peripheral devices (instruments) that you may have. 
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Hardware Requirements 
This subsection lists the minimum hardware requirements that your 
PC must conform to in order to run Navigator properly.  
While Navigator is designed to run successfully on the minimum 
configuration, we also include a recommended hardware setup that 
ensures optimal performance from the Navigator software. 

Minimum System Requirements: 

• Pentium® III 

• 64MB of RAM 

• 100MB available free space on your disk drive 

• Monitor capable of displaying 640 x 480 resolution 

• CD ROM drive 

• Windows 98/ME/2000/XP (will not run on Windows 95/NT4) 

Recommended System Requirements: 

• Pentium III or higher 

• 128MB of RAM or more 

• NVIDIA® GeForce graphics card 

• Windows 2000/XP 

 

Setting Your PC Monitor’s Colors for Best Display 
To fully utilize Navigator’s color display properties, we recommend 
that you set your PC’s monitor to the highest color display/resolution 
setting that it can support above 256-colors.  (It is important to note 
that Navigator will not run if 256-colors, or less, are selected.)  
This is typically done by displaying the Desktop Properties screen in 
Windows (right-click the mouse with the cursor on your desktop), 
then clicking the Settings tab.  Choose the highest color setting your 
monitor and PC can handle.  Refer to your PC/Windows user manual 
for more information about setting display colors and resolution. 
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Installing Navigator 

The steps you follow to install Navigator depend upon whether you 
are installing from a CD or from Raymarine’s Web site on the 
Internet.  Both of these methods are explained in this section, and both 
consist of a short sequence of installation wizard screens containing 
simple steps that you must complete.  After you have successfully 
installed Navigator, you will need your Navigator License Key(s).  
A License Key is a sequence of digits and characters you enter  initial 
configuration (explained later in this chapter) to activate Navigator 
and enable its various options modules.  You need a unique License 
Key for Navigator, and one for each optional module you are adding.  
These keys can be purchased for immediate use on the Raymarine 
Web site.   

The subsections that follow explain how to install Navigator.   

Installing From a CD 

To install Navigator from a CD: 

1. Insert the CD into your PC.  After a moment or two, 
the InstallShield Wizard Welcome screen (Figure 2-1) 
is displayed. 
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Figure 2-1.  InstallShield Wizard Welcome Screen 

2. Click Next.  The InstallShield Wizard (ISW) License 
Agreement screen (Figure 2-2) is displayed.  This screen 
contains Navigator’s Licensing Agreement/Legal Disclaimers. 

 

Figure 2-2.  InstallShield Wizard License Agreement Screen  

Click I accept… , then  
click Next to continue 
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3. Make our Legal Department happy by reading all the text, 
then click the checkbox beside “I accept …” and click Next 
to display the ISW Customer Information screen (Figure 2-3). 

 

Figure 2-3  InstallShield Wizard Customer Information Screen 

4. Type the name of the person and the organization to whom 
this version of Navigator is being licensed, then choose 
whether you want Navigator to be used just by that specific 
individual or by anyone with access to the computer.  Click 
Next to display the ISW Setup Type screen (Figure 2-4). 

Type your name and organization,  
set access, then click Next to continue 
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Figure 2-4  InstallShield Wizard Setup Type Screen  

The ISW Setup Type screen allows you to choose which 
components of Navigator you want installed.  The choices 
are as follows: 

Ø Complete –  Installs Navigator and all subcomponents 

Ø Custom –  Installs only the Navigator subcomponents 
you choose (A selection screen is displayed 
after you pick this option and click Next.) 

5. Click Complete or Custom, then click Next to continue.  
If you select Complete, skip to Step 10.   
If you select Custom, continue with this step. 

The ISW Custom Setup screen (Figure 2-5) is displayed, 
and enables you to select the Navigator components you 
want installed.  As shown in Figure 2-5, select the  
drop-down menu beside a component, then choose an 
installation approach from the displayed menu items. 

Select the installation setup you want, 
then click Next to continue 
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Figure 2-5.  InstallShield Wizard Custom Setup Screen  

The ISW Custom Setup screen choices are defined as follows: 

Ø This feature will be installed on local hard drive – 
installs selected component only 

Ø This feature, and all subfeatures, will be installed 
on local hard drive – installs selected component and 
all related subcomponents 

Ø This feature will be installed when required – ????? 

Ø This feature will not be available – does not install 
the selected component 

Keep in mind that you need a License Key for each Optional 
Module you are installing in addition to Navigator. 

6. Select the components and the installation methods you want, 
then click Next to continue.  The ISW Ready to Install screen 
is displayed (Figure 2-6). 

First, click drop-down menu beside component, then, choose the method of installation  

Click Space to check the space available on your drives 
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Figure 2-6.  InstallShield Wizard Ready to Install Screen  

7. Click Install on the ISW Ready to Install screen to begin the 
installation.  The progress of the installation is displayed on 
the screen, and after a few moments, the ISW Completed 
screen (Figure 2-7) appears. 

8. Click Finish to complete the installation. 

 
Figure 2-7.  InstallShield Wizard Completed Screen  
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Installing From the Internet 

Installation from Raymarine’s Web site is very similar to installing 
from a CD.   

To install Navigator from the Internet, do the following: 

1. Point your Internet browser to:  

www.raymarine.com/raytech 

2. Follow the instructions on the screen to download Navigator. 
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Overview 
This chapter shows you around Navigator’s user interface, illustrating 
and explaining the functions and components of the following: 

• Navigator main interface  

• Main drop-down menus 

• Toolbars 

• Functionbars (Standard, Radar, and Sonar) 

The sections that follow give you details about all drop-down menu 
hierarchies/submenus and how to access them, as well as how to 
display the various Toolbars and Functionbars and what they do.  
All menu levels and functions are illustrated and described, 
enabling you to work smoothly and efficiently within Navigator. 

 

Main Interface Component Descriptions 
This section illustrates the main user interface, and identifies its 
various components.  The interface is composed of standard drop-
down and pop-up menus, Toolbars and Functionbars.  You simply 
point-and-click to access most functions, and you can right-click on 
most any component to display context-sensitive help.  Toolbars and 
Functionbars can be moved around the Navigator screens and charts 
(by clicking and dragging), and “docked” (positioned) wherever you 
need them to display.  Navigator retains your settings from session to 
session, and re-displays the interface the same way each time. 
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Figure 3-1.  Navigator’s Main Interface 
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Drop-Down Menus 

This section shows each of the main interface drop-down menus  
(File, Waypoint, etc. — Figures 3-2 through 3-9) and gives brief 
functional descriptions of each menu item.   

File Menu 

 

Figure 3-2.  File Drop-Down Menu Item Descriptions  

 

Waypoint Menu 

 

Figure 3-3.  Waypoint Drop-Down Menu Item Descriptions  
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Route Menu 

 

Figure 3-4.  Route Drop-Down Menu Item Descriptions  

 

Tools Menu 

 

Figure 3-5.  Tools Drop-Down Menu Item Descriptions  
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Tools/Pre-Start Menu 

 

Figure 3-6.  Tools/Pre-Start Drop-Down Menu Item Descriptions  

 

View Menu 

 

Figure 3-7.  View Drop-Down Menu Item Descriptions  
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Window Menu 

 

Figure 3-8.  Window Drop-Down Menu Item Descriptions  

 

Help Menu 

 

Figure 3-9.  Help Drop-Down Menu Item Descriptions  
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Toolbars 
This section shows each of the Toolbars (Standard, Charting, etc. — 
Figures 3-10 through 3-21) and gives brief functional descriptions of 
each Toolbar item.   

 

Standard Toolbar 

 
Figure 3-10.  Standard Toolbar Item Descriptions  

 

Waypoints and Routes Toolbar 

 

Figure 3-11.  Waypoints and Routes Toolbar Item Descriptions  
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Charting Toolbar 

 

Figure 3-12.  Charting Toolbar Item Descriptions  

 

Alarm Toolbar 

 

Figure 3-13.  Alarm Toolbar Item Descriptions  
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Animation Toolbar 

 

Figure 3-14.  Animation Toolbar Item Descriptions  

 

Tides/Currents Toolbar 

 

Figure 3-15.  Tides/Currents Toolbar Item Descriptions  
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3-D View Toolbar 

 

Figure 3-16.  3-D View Toolbar Item Descriptions  

 

Fishing Toolbar 

 

Figure 3-17.  Fishing Toolbar Item Descriptions  
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Yacht Racing Toolbar 

 

Figure 3-18.  Yacht Racing Toolbar Item Descriptions  

Pre-Start Toolbar 

 

Figure 3-19.  Pre-Start Toolbar Item Descriptions  

Weather Toolbar 

 

Figure 3-20.  Weather Toolbar Item Descriptions  
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Pathfinder Panel Toolbar 

 

Figure 3-21.  Pathfinder Toolbar Item Descriptions  

 

Functionbar Menus 
 

Standard Functionbar  
This subsection illustrates the Standard Functionbar’s menu hierarchy  
(Figure 3-22), then gives brief explanations for the function of the 
buttons on each menu level (Figures 3-23 through 3-30).   
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Figure 3-22.  Standard Functionbar Menu Hierarchy 
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Route Button 

 

Figure 3-23.  Functionbar Route Button Descriptions  

Goto Button  

 

Figure 3-24.  Functionbar Goto Button Descriptions  

Marks Button  

 

Figure 3-25.  Functionbar Marks Button Descriptions  
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Top-Level “More” Button  

 

Figure 3-26.  Functionbar Top-Level “More” Button Descriptions  

 

Second-Level “More” Button  

 

Figure 3-27.  Functionbar Second-Level “More” Button Descriptions  
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File Button  

 

Figure 3-28.  Functionbar File Button Descriptions  

 

Weather Animation Button  

 

Figure 3-29.  Functionbar Weather Animation Button Descriptions  
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Setup Button  

 

Figure 3-30.  Functionbar Setup Button Descriptions  

 

 

Radar Functionbar  
This subsection illustrates the Radar Functionbar’s menu hierarchy  
(Figure 3-31), then gives brief explanations for the function of the 
buttons on each menu level (Figures 3-32 through 3-37).   
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Figure 3-31.  Radar Functionbar Menu Hierarchy 
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Heading Mode Button  

 

Figure 3-32.  Radar Functionbar Heading Mode Button Descriptions  

Targets Button  

 

Figure 3-33.  Radar Functionbar Targets Button Descriptions  

Marpa Button  

 
Figure 3-34.  Radar Functionbar Marpa Button Descriptions  
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Gain Button  

 

Figure 3-35.  Radar Functionbar Gain Button Descriptions  
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VRM/EBL Buttons  

The VRM/EBL Functionbar buttons can only be accessed in an 
open Radar window by clicking the VRM/EBL button on the 
Pathfinder Panel Toolbar — see Figure 3-21.   

 

 

Figure 3-36.  Radar Functionbar VRM/EBL Button Descriptions  
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Tune Button  

The Tune Functionbar button can only be accessed in an open Radar 
window by clicking the MULTI button on the Pathfinder Panel Toolbar 
— see Figure 3-21.   

 

 

Figure 3-37.  Radar Functionbar Tune Button Descriptions  

 

Sonar Functionbar  
This section illustrates the Sonar Functionbar’s menu hierarchy  
(Figure 3-38), then gives brief explanations for the function of the 
buttons on each menu level (Figures 3-39 through 3-44).   
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Figure 3-38.  Sonar Functionbar Menu Hierarchy 
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Frequency Button  

 

Figure 3-39.  Sonar Functionbar Frequency Button Descriptions  

 

Zoom Button  

 

Figure 3-40.  Sonar Functionbar Zoom Button Descriptions  
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Bottom Lock Button  

 

Figure 3-41.  Sonar Functionbar Bottom Lock Button Descriptions  

 

A-Scope Button  

 

Figure 3-42.  Sonar Functionbar A-Scope Button Descriptions  
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VRM/EBL Buttons  

The VRM/EBL Functionbar buttons can only be accessed in an open 
Sonar window by clicking the VRM/EBL button on the Pathfinder 
Panel Toolbar — see Figure 3-21.   

 

 

Figure 3-43.  Sonar Functionbar VRM/EBL Button Descriptions  
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Alarm Buttons  

The Alarm Functionbar buttons can only be accessed in an open Sonar 
window by clicking the ALARMS button on the Pathfinder Panel 
Toolbar — see Figure 3-21.   

 

 

Figure 3-44.  Sonar Functionbar Alarm Button Descriptions  
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Customizing the Interface  
This section describes how you can tailor Navigator’s interface to 
display only the information you require.  It explains how use the 
Customize dialog box to modify and personalize the following areas 
of Navigator: 

• Drop-down menu commands 

• Toolbars 

• Keyboard input 

• Toolbar and Menu display appearance 

• Toolbar and Menu display behavior 

 

Using the Customize Dialog Box  
This subsection illustrates the Customize dialog box and also shows 
and explains how to use its various tabs (Figures 3-45 through 3-49).  
Each tab displays a different set of options and parameters, enabling 
you to alter the appearance and behavior of many parts of Navigator’s 
interface to better suit your needs.   
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Commands Tab  

The Commands tab of the Customize dialog box enables you to 
customize Navigator’s drop-down menus to display the commands 
you want to see, rather than the defaults.   

To customize drop-down menus: 

1. From the View menu (or right-click near the Toolbar display 
area), select Customize to display the Customize dialog box 
(Figure 3-45). 

2. In the Categories window, select the drop-down menu that 
contains the command you want to move to another drop-
down menu.  The available commands for that menu are 
displayed in the Commands window.  

3. Highlight the command you want to add, then drag it over 
to the name of the drop-down menu you want to add it to. 

 

Figure 3-45.  Customize Dialog Box Commands Tab  

STEP 1.  Select the 
drop-down menu 
that contains the 
command(s) you 
want to move 

STEP 2.  Highlight 
and drag command 
to desired menu in 
Categories window 

TIP:  Scroll down and 
select All Commands to 
display all available 
commands 
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Toolbars Tab  

The Toolbars tab of the Customize dialog box enables you to restore 
Navigator’s Toolbars to their factory default states, and also allows 
you to create and name (and rename) custom Toolbars.   

To display the Toolbars tab: 

1. From the View menu (or right-click near the Toolbar display 
area), select Customize to display the Customize dialog box.  

2. Click the Toolbars tab (Figure 3-46).   

To reset Toolbars to original default settings: 

1. Check the box(es) beside the Toolbar(s) you want to reset 

2. Click Reset; or if you want to reset all the Toolbars at once, 
click Reset All. 

To create and name a custom Toolbar: 

1. Click New.  The Toolbar Name dialog box is displayed 
(Figure 3-46).   

2. Type the name you want for the Toolbar (up to 50 characters) 
then click OK.  The new Toolbar appears in the Toolbar 
window and also appears on the screen.   

To rename a custom Toolbar: 
(Only Toolbars that you have created can be renamed or deleted.) 

1. Click Rename.  The Toolbar Name dialog box is displayed 
(Figure 3-46).   

2. Type the new name you want for the Toolbar (up to 50 
characters) then click OK.  The new Toolbar appears in 
the Toolbar window and also appears on the screen.   
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Figure 3-46.  Customize Dialog Box Toolbars Tab  

 

Check the Toolbars 
you want to display 
or modify 

Click button to 
perform desired 
operation on Toolbar  
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Keyboard Tab  

The Keyboard tab of the Customize dialog box enables you to 
associate keystroke shortcuts to commonly-used commands in 
Navigator.  For example, to display the Layers dialog box, you might 
assign the keys Ctrl+L.  Then, each time you press that sequence of 
keys, the Layers dialog box appears.   

To associate keystrokes with commands: 

1. From the View menu (or right-click near the Toolbar display 
area), select Customize to display the Customize dialog box.  

2. Click the Keyboard tab (Figure 3-47).   

3. From the Category drop-down menu, select the menu that 
contains the command you want to create a shortcut for. 

4. In the Press New Shortcut Key window, type the key 
sequence you want to represent the command.   

5. Click Assign to complete creating the shortcut. 

 
Figure 3-47.  Customize Dialog Box Keyboard Tab  

STEP 1.  Select the 
drop-down menu 
that contains the 
command you want  

STEP 2.  Highlight 
the command you 
want to shortcut  

TIP:  Scroll down and 
select All Commands to 
display all commands 

STEP 4.  Click Assign  

STEP 3.  Type key sequence 
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Menu Tab  

The Menu tab of the Customize dialog box is currently non-functional 
within Navigator; however, it will display if the tab is clicked.   

 

Figure 3-48.  Customize Dialog Box Menu Tab  
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Options Tab  

The Options tab of the Customize dialog box contains checkboxes 
that control Toolbar and icon display characteristics.  You can also 
download a new appearance profile for the interface that changes 
the “look and feel” of the controls without affecting their behavior 
or command structures. 

To display the Options tab: 

1. From the View menu (or right-click near the Toolbar display 
area), select Customize to display the Customize dialog box.  

2. Click the Options tab (Figure 3-49).   

3. Check the items you want displayed, or to change the “look 
and feel” of Navigator’s interface, click Visualizations and 
follow the instructions given.  Figure 3-49 shows an example 
of a “before” and “after” Toolbar. 

 
Figure 3-49.  Customize Dialog Box Options Tab  

Click Visualizations 
to download new 
appearance profiles 
for the interface  


